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Bab 1

Perkenalan

1.1 KiCad

KiCad adalah perangkat lunak sumber-terbuka (open-source) untuk membuat diagram skematik elektronika dan desain papan
PCB (Printed Circuit Board). Di dalam tampilannya yang singular, KiCad sebenarnya terdiri dari serangkaian aplikasi berikut
ini:

• KiCad : Manajer proyek

• Eeschema : Editor skematik dan komponen

• Pcbnew : Editor tata letak papan sirkuit dan footprint

• GerbView : Penampil Gerber

Bersama dengan perangkat lunak di atas, disertakan pula 3 buah peralatan berikut:

• Bitmap2Component: Pembuat komponen untuk logo. Aplikasi ini digunakan untuk membuat komponen skematik atau
footprint dari sebuah gambar bitmap.

• PcbCalculator: Kalkulator untuk menghitung komponen untuk regulator, ukuran jalur terhadap arus, garis transmisi, dsb.

• Pl Editor: Editor tata letak halaman.

Peralatan tersebut biasanya dijalankan dari manajer proyek, namun bisa juga dijalankan sebagai aplikasi yang berdiri sendiri.

KiCad tidak memiliki batasan ukuran papan PCB, dan dapat dengan mudah menangani hingga 32 lapisan (layer) tembaga, 14
lapisan teknis, dan 4 lapisan pelengkap.

Kicad mampu menghasilkan semua berkas yang dibutuhkan untuk membangun papan PCB, antara lain:

• Berkas Gerber untuk photo-plotter

• Berkas drilling

• Berkas lokasi komponen

Sebagai perangkat lunak sumber-terbuka yang berlisensi GPL, KiCad sangat ideal bagi pengguna yang berorientasi proyek dalam
pembuatan perangkat keras elektronik dengan citarasa sumber-terbuka.

KiCad tersedia untuk sistem operasi Linux, Windows, dan Apple macOS.

1.2 Berkas dan Folder KiCad

KiCad menggunakan ekstensi berkas berikut dalam pembuatan skematik dan papan sirkut elektronik.

Berkas manajer proyek:
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*.pro Berkas kecil yang berisi beberapa parameter untuk proyek yang sedang dikerjakan, termasuk
daftar pustaka komponen.

Berkas editor skematik:

*.sch Berkas skematik, berkas ini tidak menyertakan komponen di dalamnya.
*.lib Berkas pustaka komponen skematik, berisi deskripsi komponen: bentuk grafis, pin, dan atribut.
*dcm Dokumentasi pustaka komponen skematik, berisi beberapa deskripsi komponen: komentar,

kata kunci, dan referensi ke lembar data (datasheet).
*_cache.lib Berkas tembolok pustaka komponen skematik, berisi salinan dari komponen yang digunakan

pada proyek skematik.
sym-lib-table Daftar pustaka simbol (symbol library table): daftar pustaka simbol yang tersedia pada editor

skematik.

Berkas dan folder editor papan sirkuit:

*.kicad_pcb Berkas papan sirkuit yang berisi berbagai informasi kecuali tata letak halaman.
*.pretty Folder pustaka untuk footprint. Folder itu sendiri adalah pustaka.
*.kicad_mod Berkas footprint, berisi satu deskripsi footprint pada setiap berkas.
*.brd Berkas papan sirkuit dalam format lama. Dapat dibaca namun tidak dapat ditulis oleh editor

papan sirkuit versi saat ini.
*.mod Pustaka footprint dalam format lama. Dapat dibaca oleh editor footprint atau editor papan

sirkuit, namun tidak dapat ditulis.
fp-lib-table Daftar pustaka footprint (footprint library table): daftar dari pustaka footprint (dalam berbagai

format) yang dimuat oleh papan sirkuit, editor footprint, atau CvPcb.

Berkas-berkas umum:

*.kicad_wks Berkas deskripsi tata letak halaman, untuk pengguna yang membutuhkan sebuah lembar kerja
dengan tampilan kustom.

*.net Berkas Netlist yang dibuat oleh skematik, dan dibaca oleh editor papan sirkuit. Berkas ini
terhubung dengan berkas .cmp, untuk pengguna yang lebih suka menggunakan berkas yang
terpisah untuk hubungan komponen/footprint.

Berkas khusus:

*.cmp Hubungan antara komponen-komponen yang digunakan pada skematik dan footprint. Berkas
ini dapat dibuat oleh Pcbnew dan diimpor oleh Eeschema. Berkas ini digunakan untuk
mengimpor perubahan dari Pcbnew ke Eeschema, bagi pengguna yang mengubah footprint
suatu komponen di dalam Pcbnew (misalnya dengan menggunakan perintah Exchange
Footprints) dan ingin mengimpor perubahan tersebut ke skematik.

Berkas-berkas lain:

Berkas-berkas berikut dibuat oleh KiCad untuk keperluan fabrikasi dan dokumentasi.

*.gbr Berkas Gerber, untuk fabrikasi.
*.drl Berkas drill (format Excellon), untuk fabrikasi.
*.pos Berkas posisi (format ASCII), untuk mesin pemasang komponen otomatis.
*.rpt Berkas laporan (format ASCII), untuk dokumentasi.
*.ps Berkas plot (postscript), untuk dokumentasi.
*.pdf Berkas plot (format pdf), untuk dokumentasi.
*.svg Berkas plot (format SVG), untuk dokumentasi.
*.dxf Berkas plot (format DXF), untuk dokumentasi.
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*.plt Berkas plot (format HPGL), untuk dokumentasi.
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Bab 2

Instalasi dan Konfigurasi

2.1 Opsi Tampilan

Perender dengan akselerasi perangkat keras pada Pcbnew dan Gerbview membutuhkan kartu video yang mendukung OpenGL
v2.1 atau lebih tinggi.

2.2 Inisialisasi Konfigurasi Default

Berkas konfigurasi default dengan nama kicad.pro berada pada direktori kicad/template. Berkas ini digunakan sebagai
templat bagi setiap proyek yang baru dibuat dan digunakan untuk mengatur daftar berkas pustaka yang dimuat oleh Eeschema.
Beberapa parameter lain untuk Pcbnew (ukuran teks default, ketebalan garis default, dsb.) juga disimpan di sini.

Mungkin ada juga berkas konfigurasi default dengan nama fp-lib-table. Berkas tersebut akan digunakan hanya satu kali saja
untuk membuat daftar pustaka footprint. Atau jika berkas tersebut tidak tersedia, maka daftar pustaka footprint akan dibuat dari
awal.

2.3 Mengubah Konfigurasi Default

Jika diinginkan, berkas default kicad.pro bebas untuk dimodifikasi.

Pastikan bahwa Anda memiliki hak tulis ke kicad/template/kicad.pro

Jalankan KiCad dan bukalah proyek kicad.pro.

Jalankan Eeschema melalui manajer KiCad. Lakukan pengaturan konfigurasi Eeschema, untuk mengatur daftar pustaka yang
ingin Anda gunakan setiap kali Anda membuat proyek baru.

Jalankan Pcbnew melalui manajer KiCad. Lakukan pengaturan konfigurasi Pcbnew, khususnya pada daftar pustaka footprint.
Pcbnew akan membuat atau memperbarui berkas daftar pustaka yang disebut footprint library table. Terdapat 2 berkas daf-
tar pustaka (dinamai fp-lib-table): Berkas pertama (berada di direktori rumah pengguna) berfungsi secara global untuk semua
proyek, dan berkas kedua (berada di direktori proyek) adalah opsional, dan berfungsi secara spesifik untuk proyek terkait.

2.4 Konfigurasi Path

Di KiCad, kita bisa mendefinisikan beberapa path dengan menggunakan environment variable. KiCad mendefinisikan beberapa
environment variable secara internal, dan bisa digunakan untuk mendefinisikan path untuk pustaka, bentuk 3D, dan sebagainya.

Hal ini berguna ketika path absolut tidak diketahui atau akan ada perubahan (misalnya saat Anda mentransfer sebuah proyek ke
komputer lain), dan juga ketika satu path dasar dibagi oleh item-item yang mirip. Pertimbangkan hal berikut yang bisa diinstal
pada berbagai lokasi yang berbeda:
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• Pustaka komponen Eeschema

• Pustaka footprint Pcbnew

• berkas-berkas bentuk 3D yang digunakan pada definisi footprint

Sebagai contoh, path dari pustaka footprint connect.pretty, saat menggunakan environment variable KISYSMOD, akan didefi-
nisikan sebagai: ${KISYSMOD}/connect.pretty

Opsi berikut ini mengijinkan Anda mendefinisikan sebuah path dengan menggunakan sebuah environment variable, dan menam-
bahkan environment variable Anda sendiri untuk mendefinisikan path-path pribadi, jika diperlukan.

Beberapa environment variable KiCad:

KICAD_PTEMPLATES Templates used during project creation (DEPRECATED as of version 5.0.0-rc2, use
KICAD_TEMPLATE_DIR instead). If you are using this variable, it must be defined.

KICAD_SYMBOL_DIR Base path of symbol library files.
KIGITHUB Frequently used in example footprint lib tables. If you are using this variable, it must be

defined.
KISYS3DMOD Base path of 3D shapes files, and must be defined because an absolute path is not usually used.
KISYSMOD Base path of footprint library folders, and must be defined if an absolute path is not used in

footprint library names.
KICAD_TEMPLATE_DIRLocation of templates installed with KiCad.
KICAD_USER_TEMPLATE_DIRLocation of personal templates.

Ingat juga bahwa environment variable KIPRJMOD selalu didefinisikan secara internal oleh KiCad, dan merupakan path ab-
solut untuk proyek yang sedang dibuka.

Sebagai contoh, ${KIPRJMOD}/connect.pretty selalu mengarah ke folder connect.pretty (pustaka footprint pretty) yang berada
di dalam folder proyek yang sedang dibuka.

Jika Anda memodifikasi konfigurasi path , Anda harus menutup dan menjalankan kembali KiCad, untuk menghindari
masalah dalam menangani path.

2.5 Inisialisasi Peralatan-peralatan Eksternal

Anda bisa memilih editor teks dan penampil PDF kesukaan Anda. Pengaturan ini akan digunakan setiap Anda ingin membuka
sebuah teks atau berkas PDF.

Pengaturannya dapat diakses melalui menu Preferences:
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2.5.1 Pemilihan Editor Teks

Sebelum bisa menggunakan editor teks untuk melihat/mengedit berkas-berkas pada proyek yang sedang Anda kerjakan, Anda
harus memilih editor teks yang ingin Anda gunakan.

Pilih Preferences → Set Text Editor untuk memilih editor teks yang ingin Anda gunakan.

2.5.2 Pemilihan Penampil PDF

Anda bisa menggunakan penampil PDF default atau memilih penampil PDF yang Anda sukai.

Untuk mengganti penampil PDF default, gunakan Preferences → PDF Viewer → Set PDF Viewer untuk memilih program
penampil PDF, kemudian pilih Preferences → PDF Viewer → Favourite PDF Viewer.

Pada sistem operasi Linux, penampil PDF default seringkali menggunakan aplikasi yang jarang kita gunakan, oleh karena itu
lebih direkomendasikan untuk memilih penampil PDF yang kita sukai.

2.6 Membuat Proyek Baru

Dalam mengelola sebuah proyek KiCad yang berisi berkas-berkas skematik, papan PCB, pustaka tambahan, berkas manufaktur
untuk photo-tracing, drilling dan berkas peletakan komponen otomatis, direkomendasikan untuk membuat sebuah proyek dengan
langkah sebagai berikut:

• Membuat sebuah direktori kerja untuk proyek yang akan kita kerjakan (melalui KiCad atau menggunakan cara yang
lain).

• Pada direktori ini, gunakan KiCad untuk membuat sebuah berkas proyek (berkas dengan ekstensi .pro) melalui ikon
"Create a new project" atau "Create a new project from template".

Awas
Gunakan sebuah direktori yang unik untuk setiap proyek KiCad. Jangan memasukkan beberapa proyek ke dalam satu
direktori.

KiCad membuat sebuah berkas dengan ekstensi .pro yang menyimpan sejumlah parameter untuk manajemen proyek (misalnya
daftar pustaka yang digunakan di skematik). Nama default berkas skematik utama dan berkas papan sirkuit diambil dari nama
proyek. Dengan demikian, jika kita membuat sebuah proyek dengan nama example.pro di dalam sebuah direktori dengan nama
example, maka berkas-berkas default berikut ini akan dibuat:
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example.pro Berkas manajemen proyek.
example.sch Berkas skematik utama.
example.kicad_pcb Berkas papan PCB.
example.net Berkas Netlist.
example.* Aneka macam berkas yang dibuat oleh program-program lain.
example-cache.lib Berkas pustaka yang dibuat secara otomatis dan digunakan oleh editor skematik yang

berisi cadangan komponen yang digunakan di skematik.

2.7 Mengimpor Proyek

KiCad mampu mengimpor berkas-berkas yang dibuat dengan paket perangkat lunak yang lain. Saat ini, KiCad baru mendukung
berkas dari Eagle 6.x atau yang lebih baru (format XML).

Untuk mengimpor sebuah proyek dari perangkat lunak lain, Anda harus memilih sebuah berkas skematik atau tata letak PCB
pada tampilan dialog pemilih berkas yang akan diimpor. Berkas-berkas skematik dan tata letak PCB yang akan diimpor harus
memiliki nama berkas yang sama (misalnya project.sch dan project.brd). Jika berkas yang akan diimpor sudah dipilih, Anda
akan diminta untuk memilih sebuah direktori untuk menyimpan berkas-berkas hasil impor, yang akan disimpan sebagai sebuah
proyek KiCad.



KiCad 8 / 20

Bab 3

Menggunakan Manajer Proyek KiCad

Manajer proyek KiCad (kicad atau kicad.exe) adalah sebuah aplikasi yang memudahkan kita menjalankan aplikasi lain (editor
skematik dan PCB, penampil Gerber dan peralatan lainnya) saat membuat sebuah desain.

Menjalankan aplikasi dari Manajer KiCad memiliki beberapa keuntungan, antara lain:

• menjaga saling keterkaitan antara editor skematik dan editor papan sirkuit.

• menjaga saling keterkaitan antara editor skematik dan pemilih footprint (CvPcb).

Bagaimanapun, Anda hanya mengedit berkas-berkas proyek yang saat ini dibuka. Ketika berbagai peralatan yang tersedia di
KiCad dijalankan secara langsung secara stand alone tanpa melalui manajer proyek KiCad, Anda dapat membuka berkas apapun
di dalam semua proyek, namun keterkaitan antar aplikasi akan menjadi terganggu.

3.1 Jendela Manajer Proyek

Layar utama KiCad terdiri dari sebuah tampilan pohon proyek, sebuah jendela peluncur yang berisi tombol-tombol yang digu-
nakan untuk menjalankan berbagai peralatan, dan sebuah layar pesan. Menu dan bilah alat dapat digunakan untuk membuat,
membaca dan menyimpan berkas-berkas proyek.
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3.2 Jendela Peluncur Peralatan

Anda dapat menjalankan semua peralatan yang tersedia di KiCad secara standalone.

Jendela peluncur terdiri dari 8 buah tombol yang akan menjalankan perintah-perintah berikut (1 sampai 8, dari kiri ke kanan):

1 Eeschema Editor skematik.
2 LibEdit Editor komponen dan manajer pustaka komponen.
3 Pcbnew Editor tata letak papan sirkuit.
4 FootprintEditor Editor footprint dan manajer pustaka footprint.
5 Gerbview Penampil berkas Gerber. Juga bisa menampilkan berkas drill.
6 Bitmap2component Alat untuk membuat footprint atau komponen dari gambar bitmap hitam-putih untuk

membuat logo.
7 Pcb Calculator Alat untuk menghitung lebar track dan lain-lain.
8 Pl Editor Editor layout halaman, untuk membuat/mengubah referensi bingkai halaman.

3.3 Tampilan Pohon Proyek

Klik-ganda pada berkas skematik untuk menjalankan editor skematik, yang dalam contoh di atas akan membuka berkas pic_programmer.sch.

Klik-ganda pada berkas PCB untuk menjalankan editor tata letak PCB, yang dalam contoh di atas akan membuka berkas
pic_programmer.kicad_pcb.

Melakukan klik-kanan pada berkas yang ada di pohon proyek akan mengijinkan kita melakukan manipulasi berkas secara umum.

3.4 Bilah Alat Bagian Atas

Kita dapat melakukan beberapa perintah berkas dasar dengan mengakses bilah alat bagian atas pada KiCad:
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Membuat proyek baru. Jika di direktori kicad/template terdapat berkas templat
(kicad.pro), maka berkas tersebut akan disalin ke dalam direktori kerja.

Membuat sebuah proyek berdasarkan templat yang sudah ada.

Membuka proyek yang sudah ada.

Memperbarui dan menyimpan pohon proyek yang sedang dibuka.

Membuat sebuah arsip zip dari keseluruhan proyek, termasuk file skematik, pustaka,
PCB, dsb.

Memuat kembali (reload) tampilan pohon, kadang perintah ini diperlukan setelah kita
melakukan perubahan pada suatu pohon.
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Bab 4

Templat Proyek

Penggunaan templat proyek akan memudahkan kita dalam melakukan pengaturan sebuah proyek baru dengan pengaturan yang
telah ditentukan sebelumnya. Templat mungkin berisi bentuk papan PCB yang sudah ditentukan, berbagai posisi konektor,
elemen-elemen skematik, aturan desain, dan sebagainya. Dimungkinkan juga untuk memasukkan berkas skematik dan/atau PCB
yang lengkap sebagai berkas-berkas awal proyek baru.

4.1 Menggunakan Templat

Menu File → New Project → New Project from Template akan membuka dialog Project Template Selector:

Klik pada sebuah ikon templat akan menampilkan informasi templat, dan klik OK untuk membuat proyek baru. Berkas-berkas
templat akan disalin ke dalam lokasi proyek yang baru, dengan nama berkas yang sesuai dengan nama proyek yang baru.

Setelah memilih sebuah templat:
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4.2 Lokasi Templat:

KiCad akan mencari berkas-berkas templat pada path berikut:

• path defined in the environment variable KICAD_USER_TEMPLATE_DIR

• path defined in the environment variable KICAD_TEMPLATE_DIR

• Templat sistem: <kicad bin dir>/../share/kicad/template/

• Templat pengguna:

– Unix: ~/kicad/templates/

– Windows: C:\Documents and Settings\username\My Documents\kicad\templates

– Mac: ~/Documents/kicad/templates/

• When the environment variable KICAD_PTEMPLATES is defined there is a third tab, Portable Templates, which lists templa-
tes found at the KICAD_PTEMPLATES path (DEPRECATED).

4.3 Membuat Templat

Nama templat adalah nama direktori penyimpanan berkas-berkas templat. Direktori metadata adalah sebuah subdirektori dengan
nama meta yang berisi berkas-berkas yang menjelaskan templat tersebut.

Semua berkas dan direktori di dalam sebuah templat akan disalin ke path proyek yang baru pada saat proyek tersebut dibuat
dengan menggunakan templat, kecuali meta.

Ketika sebuah proyek baru dibuat dari sebuah templat, semua berkas dan direktori yang namanya dimulai dengan nama templat
akan diganti dengan nama berkas proyek yang baru, tidak termasuk ekstensi berkas.
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Metadata berisi satu buah berkas yang dibutuhkan, dan mungkin berisi beberapa berkas opsional. Seluruh berkas harus dibuat
oleh pengguna dengan menggunakan editor teks atau berkas proyek KiCad sebelumnya, dan diletakkan di dalam struktur direktori
yang diperlukan.

Berikut adalah contoh berkas-berkas proyek untuk templat raspberrypi-gpio:

Dan berkas-berkas metadata:

4.3.1 Berkas yang Dibutuhkan:

meta/info.html Informasi dalam format HTML berisi penjelasan templat.

Tag <title> menentukan nama aktual dari templat yang ditampilkan kepada pengguna pada saat memilih templat. Ingat bahwa
nama templat proyek akan dipotong jika terlalu panjang. Dikarenakan batasan spasi pada fonta, hanya 7 atau 8 karakter saja yang
bisa ditampilkan.

Penggunaan HTML berarti gambar bisa dengan mudah dimasukkan tanpa perlu membuat skema yang baru. Hanya tag-tag
HTML dasar yang dapat digunakan pada dokumen ini.

Berikut adalah contoh berkas info.html:
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<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML>
<HEAD>
<META HTTP-EQUIV="CONTENT-TYPE" CONTENT="text/html;
charset=windows-1252">
<TITLE>Raspberry Pi - Expansion Board</TITLE>
</HEAD>
<BODY LANG="fr-FR" DIR="LTR">
<P>This project template is the basis of an expansion board for the
<A HREF="http://www.raspberrypi.org/" TARGET="blank">Raspberry Pi $25
ARM board.</A> <BR><BR>This base project includes a PCB edge defined
as the same size as the Raspberry-Pi PCB with the connectors placed
correctly to align the two boards. All IO present on the Raspberry-Pi
board is connected to the project through the 0.1&quot; expansion
headers. <BR><BR>The board outline looks like the following:
</P>
<P><IMG SRC="brd.png" NAME="brd" ALIGN=BOTTOM WIDTH=680 HEIGHT=378
BORDER=0><BR><BR><BR><BR>
</P>
<P>(c)2012 Brian Sidebotham<BR>(c)2012 KiCad Developers</P>
</BODY>
</HTML>

4.3.2 Berkas-berkas Tambahan:

meta/icon.png Ikon berformat PNG dengan ukuran 64 x 64 piksel yang digunakan sebagai ikon yang bisa
di-klik pada kotak dialog pemilihan templat.

Berkas-berkas gambar lain yang digunakan oleh meta/info.html, seperti gambar berkas papan PCB pada dialog di atas, juga
diletakkan pada folder ini.
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Bagian I

Upgrading from Version 4 to Version 5
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Changes were made to the behavior to KiCad during the version 5 development that can impact projects created with older
versions of KiCad. This section serves as a guide to ensure the smoothest possible path when upgrading to version 5 of KiCad.
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Bab 5

Schematic Symbol Libraries

Schematic symbol libraries are no longer accessed using a symbol (referred to as components in version 4) look up list. Symbol
libraries are now managed by a symbol library table that behaves similarly to the footprint library table. This change is a
significant improvement, but some schematics may need manual intervention when being converted to version 5.

In previous versions, KiCad used a list of library files to search when locating symbols in the Eeschema file. When locating a
symbol, each path would be searched and the first library that held the symbol name would be used.

From v5, KiCad symbol names are prefixed with a nickname, and a lookup table matching nicknames to library paths is used to
locate the library which holds the symbol. The table is called the symbol library table and built from configuration files stored in
the user’s KiCad configuration directory and the currently loaded project directory.

To upgrade a KiCad project from v4 to v5, nicknames for all of the library files need to be created and then schematic symbol
names need to be prefixed with the correct nickname.

5.1 Global Symbol Library Table.

Eeschema v5 will automatically create a global symbol table when first started. You will be given a chance to skip this and create
your own global symbol table by hand. You only need to do this if don’t use KiCad symbol libraries at all. Otherwise it is easier
to modify the automatically generated global symbol table.

Catatan
If you track the symbol library repository, changes made to the default global symbol library table are not tracked by KiCad. You
will have to manually keep the global symbol library table up to date.

5.2 Symbol Library Table Mapping

Automatic remapping of symbols will be executed whenever a schematic is opened that has not been remapped. There are a few
steps you should take ahead of time in order for the remapping to be the most effective.

Catatan
If you have been using a development build of KiCad, copy the full default global symbol library table file (sym-lib-table) from
the template folder installed with the KiCad libraries or from the KiCad library repo to your KiCad user configuration folder. This
will replace the empty one (most likely) created by Eeschema. If you do not do this, you will most likely end up with a bunch of
broken symbol links.

https://github.com/KiCad/kicad-doc/blob/master/src/kicad/kicad_upgrading_from_v4_to_v5.adoc
https://github.com/KiCad/kicad-symbols
https://github.com/KiCad/kicad-library/blob/master/template/sym-lib-table


KiCad 18 / 20

Awas
Remapped schematics will not be compatible with older versions of KiCad. The Remap Symbols dialog will make a
backup of your schematic files and you should do the same if you remap manually.

1. If possible, keep version 4 of KiCad installed on your system unless you have never used any of the symbol libraries
distributed with KiCad.

2. If you get warning about missing libraries when you start version 4 of Eeschema, make sure to fix the missing libraries if
they contain symbols that are in the schematic before you attempt to remap your schematic. Otherwise, the correct symbol
will not be found and you will end up with broken symbol links in your schematic. You can test this by left clicking on
a symbol in the schematic and verifying that the symbol is not being loaded from the cache library. If a symbol is being
loaded from the cache library, Eeschema cannot find your part in the system or project symbol libraries. If you need a
cached part to be available to other projects on your system, you will need to integrate it into a system or project library
manually.

3. If symbol recovery is required during the remapping process, do not dismiss it. Failure to recover symbols will result in
broken symbol links or the wrong symbol being linked in the schematic.

4. During the remapping process, symbol libraries not found in the global symbol library table will be used to create a project
specific symbol library table. You can move them manually to the global symbol library table if that is your preference.

5. For the most accurate remapping, create a project library by copying the project cache file (project-name-cache.lib) to a
different file and add it to the top of the symbol library list. You must use a version of KiCad prior to the symbol library
table implementation in order to do this.

Catatan
A tool has been provided to attempt to fix remapping issues. If there are missing symbol library links in a schematic, they can
be fixed by opening the "Tools→Edit Symbol Library References. . . " menu entry and clicking on the "Map Orphans" button.

5.3 Remapping Search Order

When remapping symbols, KiCad proceeds in the following order to assign the library to a symbol:

1. Global Symbol Library Table: Symbols are preferentially mapped to the global symbol library table, if one exists.

2. Project specific libraries: Libraries listed in the project library list that are not in the global symbol library table are searched
next.

3. Project cache file: If a symbol doesn’t exist in the listed libraries above, it is first rescued — a copy is made from the cache
and placed in the proj-rescue.lib — before the symbol is mapped to this new, rescue library.

5.4 Symbol Names and Symbol Library Nickname Limitations

Symbol names may not contain <SPACE>, ’:’, ’/’.

Library nicknames may not contain <SPACE>, ’:’.

Existing symbol names with these characters must be renamed by manually editing the relevant schematic and library files.
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Bab 6

Symbol Cache Library Availability

The cache library is no longer shown in either the symbol library viewer or the symbol library editor. The cache should never be
edited because any changes are overwritten by the next schematic save.
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Bab 7

Board File Format Changes

Several new features have been added to Pcbnew which impact the board file format. Using these new features in board designs
will prevent them from being opened with previous versions of Pcbnew.

• Rounded rectangle footprint pads.

• Custom shape footprint pads.

• Footprint pad names longer than four characters.

• Keep out zones on more than a single layer.

• 3D models offset saved as millimeters instead of inches.

• Footprint text locking.

7.1 Global Footprint Library Table.

If you track the footprint library repository, changes made to the default global footprint library table are not tracked by KiCad.
You will have to manually keep the global footprint library table up to date.

https://github.com/KiCad/kicad-footprints
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